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Installing the RFIC-ER Startup Kit
for the Dionex ICS-1100/ICS-1600

1. Introduction

Reagent-Free™ Ion Chromatography with Eluent Regeneration (RFIC-ER™) is a 
low-cost alternative to RFIC™ Eluent Generation (RFIC-EG™) systems. Rather 
than generating eluent electrolytically from water, using an eluent generator with 
an electrolyte solution, RFIC-ER uses the recycled eluent mode of operation of 
the electrolytic suppressor to regenerate the starting eluent. 

The starting eluent for the RFIC-ER system is prepared manually, as usual. After 
suppression and regeneration, the eluent passes through a series of purification 
columns before being returned to the eluent bottle. With the closed-loop RFIC-ER 
system, the original 4 liters of eluent can be used for up to four weeks of 
continuous operation.

The Thermo Scientific Dionex™ ICS-1100 and ICS-1600 Ion Chromatography 
Systems are RFIC-ER–ready when shipped from the factory. To complete the 
installation, order the appropriate kit for your application:

• RFIC-ER Anion Startup Kit, Dionex ICS-1100/ICS-1600 (P/N 069570) 

• RFIC-ER Cation Startup Kit, Dionex ICS-1100/ICS-1600 (P/N 069569)

Each Startup Kit includes one Installation Kit and one Consumables Kit. Together, 
these kits contain all the consumable and non-consumable items required to 
operate an RFIC-ER system nonstop for 6 to 12 months.

NOTE The SRS™ 300 Suppressor is the only suppressor
compatible with RFIC-ER.

NOTE For information about installing an AC-ER Anion
Concentrator Column in the RFIC-ER system and
operating in concentrator mode, see Section 12.
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2. Safety Information

The ER Controller (ERC 10) is an integral element of the RFIC-ER system. The 
ERC 10 electronics monitor the volume of electrolysis gases (such as hydrogen 
and oxygen) in the eluent stream. If the predefined safety limit is exceeded, the 
ERC 10 shuts down the pump to prevent the buildup of gases in the eluent bottle.

2.1 Safety Messages

This manual contains warnings and precautionary statements that, when 
followed properly, can prevent personal injury and/or damage to the ERC 
10. Safety messages appear in bold type and are accompanied by icons, as 
shown below. 

Messages d’avertissement en français

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury.

Indicates that the function or process of the instrument may be
impaired. Operation does not constitute a hazard.

Signale une situation de danger immédiat qui, si elle n'est pas évitée,
entraînera des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures graves à mortelles.
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Warnhinweise in Deutsch

Informational messages also appear throughout this manual. These are 
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They alert
users to an unexpected result of an action, suggest how
to optimize instrument performance, etc.

2.2 ERC 10 Labels

The TUV GS and cTUVus Mark safety labels and the CE Mark label on 
the ERC 10 indicate that the ERC 10 is in compliance with the following 
standards and directives.

EMC Susceptibility and Immunity

• EN 61326 1997 + A1:1998 + A2:2001

• Low-Voltage Equipment Directive 73/23/EEC

• EMC Directive 89/336/EEC

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures mineures à modérées. Également
utilisé pour signaler une situation ou une pratique qui pourrait
gravement endommager l'instrument mais qui n'entraînera pas de
blessures.

Bedeutet unmittelbare Gefahr. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zu kleineren
oder mittelschweren Verletzungen führen. Wird auch verwendet, wenn
eine Situation zu schweren Schäden am Gerät führen kann, jedoch
keine Verletzungsgefahr besteht.
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Safety

• EN 61010-1:2001

• CAN/CSA-C22.2 No. 61010-1:2004

• UL 61010-1:2004

These symbols appear on the ERC 10 or on ERC 10 labels:

Alternating current

Protective conductor terminal

Power supply is on

Indicates a potential hazard. Refer to the user manual for an 
explanation of the hazard and how to proceed.

2.3 ERC 10 Specifications

Main Power 5 volts DC
Typical input power: 25 mW
Typical line draw: 5 mA

Operating
Temperature

4 to 40 °C (40 to 104 °F)

Operating
Humidity

5% to 95% relative humidity, noncondensing

Dimensions Height: 18.7 cm (7.375 in)
Width: 5.7 cm (2.25 in)
Depth: 3.4 cm (1.375 in)

Weight 0.38 kg (0.83 lb) 

˜
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3. Functional Description

This section presents a brief overview of key RFIC-ER components. For more 
information about the trap columns, refer to the column manual provided on the 
Thermo Scientific Reference Library DVD (P/N 053891).

Figure 1 illustrates the liquid flow path through an RFIC-ER system.

The key to RFIC-ER is operating the suppressor in the recycled eluent mode. 
During the suppression operation, the suppressor exchanges the counterion of the 
eluent and analyte for hydronium (in anion systems) or hydroxide (in cation 
systems); during the regeneration operation, the counterion is returned to the 
eluent and the excess hydronium or hydroxide is neutralized. Thus, the ion 
balance is maintained throughout the entire suppression-regeneration process.

• The ER1 is a Thermo Scientific Dionex IonPac™ Eluent Purification Column 
(anion column, AEP-ER1; cation column, CEP-ER1). The ER1 is a mixed-
bed column that includes matrix trap material. The ER1 traps any contaminant 
species that may be liberated from the separator column or suppressor (or 
introduced by the sample), thus ensuring the purity of the regenerated eluent. 
The ER1 has a secondary purpose of trapping the matrix counterions 
introduced by the sample.

Figure 1.  RFIC-ER System Fluid Schematic
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• The ER2 is a Dionex IonPac Analyte Trap Column (anion column, AAT-ER2; 
cation column, CAT-ER2). When a sample is injected into the system, it is 
important that the ions introduced in the sample do not enter the eluent bottle. 
Analyte ions in the sample can increase the background conductivity of the 
eluent, while counterions can affect the recovery of certain analytes. The ER2 
traps all analyte ions from the eluent stream, allowing the eluent to be 
regenerated for reuse.

The anion ER2 contains high-capacity microporous anion exchange resin in 
the bicarbonate form. The cation ER2 contains high-capacity microporous 
cation exchange resin in the hydronium form. 

• The ER Controller (ERC 10) is a gas monitor built into the Dionex ICS-
1100 or Dionex ICS-1600. The ERC 10 tracks the volume of gas exiting the 
two ER3 Dionex IonPac Catalyzer Columns.

During the suppression-regeneration process, water is electrolyzed to 
hydrogen and oxygen gases. In order to maintain the volume of the eluent, 
these gases need to be converted back to water. The ER3a column provides a 
delay that allows the most electroactive by-products to decay; the ER3b 
column has a platinum catalyst to complete the breakdown of any remaining 
electrolytic by-products and to reform water from the oxygen and hydrogen 
gases.

If the volume of gas exiting the ER3 columns exceeds the predefined safety 
limit, the ERC 10 shuts down the pump.

• The 4-liter eluent bottle has a dual-line cap. The outlet line is directed from 
near the top of the eluent bottle, while the inlet line is directed to the bottom of 
the eluent bottle. Thus, eluent is pumped from the top of the bottle and 
returned to the bottom. Two gas vents in the eluent bottle cap ensure that any 
gases produced by the suppressor are safely vented to the atmosphere.

The eluent bottle and cap provided in the RFIC-ER Installation Kit are
designed specifically for use with RFIC-ER systems. Do not operate
the system with any other eluent bottle or cap.

La bouteille d’éluant et son bouchon fournis dans le kit d’installation
du système RFIC-ER sont conçus spécifiquement pour les systèmes
RFIC-ER. N’utilisez aucun autre type de bouteille ou de bouchon avec
le système RFIC-ER.



Unpacking and Inspection

Doc. 065295-03 10/12 7

4. Unpacking and Inspection

Unpack the shipping containers and verify that all items listed on the packing list 
are on hand.

The RFIC-ER Anion Startup Kit, Dionex ICS-1100/ICS-1600 (P/N 069570) 
consists of:

• RFIC-ER Anion Installation Kit, Dionex ICS-1100/ICS-1600 (P/N 069568)

• RFIC-ER Anion Consumables Kit (P/N 067791)

The RFIC-ER Cation Startup Kit, Dionex ICS-1100/ICS-1600 (P/N 069569) 
consists of:

• RFIC-ER Cation Installation Kit, Dionex ICS-1100/ICS-1600 (P/N 069567)

• RFIC-ER Cation Consumables Kit (P/N 067792)

Each Installation Kit contains all non-consumable items required for an RFIC-ER 
system, including the ER1 and ER2 mounting clips, ER3a and ER3b columns, and 
eluent bottle assembly.

Each Consumables Kit contains four ER1 columns and one ER2 column.

Die Eluentenflasche und der Deckel aus dem RFIC-ER Installationskit
sind speziell für die Verwendung mit einem RFIC-ER System
bestimmt. Verwenden Sie mit diesem System keine anderen
Eluentenflaschen oder Deckel.

Substitution of non-Dionex/Thermo Fisher Scientific parts may impair
system performance and void the product warranty. For details, refer
to the warranty statement in the Dionex Terms and Conditions.
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5. Procedure Overview

These are the main steps in the RFIC-ER installation procedure:

• Install the ER3a and ER3b columns

• Install the eluent bottle

• Plumb the ER1 column for conditioning

• Condition the ER1 column

• Complete the ER1 column tubing connections

• Install the ER2 column

• Test the system for leaks

• Complete the tubing connections

• Update the Thermo Scientific Dionex Chromeleon® 7 or Chromeleon® 6.8 
Chromatography Data System software, if necessary

• Configure device properties in the Instrument Configuration program 
(Chromeleon 7) or Server Configuration program (Chromeleon 6.8)

• For a new or freshly-regenerated SRS 300 only: Condition the SRS 300 for 
16 hours

6. Initial Setup for Dionex ICS-1100/ICS-1600 Systems

To ensure that the eluent returned to the eluent bottle is identical in composition to 
the starting eluent, several RFIC-ER system components must be equilibrated 
before initial operation. This section describes the temporary connections required 
for equilibration.

6.1 Installing the ER3a and ER3b Columns

1. Verify that the Dionex ICS-1100 or Dionex ICS-1600 is set up as 
directed in the operator’s manual. The manuals are included on the 
Thermo Scientific Reference Library DVD (P/N 053891).
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2. Remove the ERC 10 from the instrument (Chromeleon 7) or timebase 
(Chromeleon 6.8) that contains the Dionex ICS-1100 or Dionex ICS-
1600. Do not remove the IC system from the instrument or 
timebase. 

3. Remove the 
coiled tubing and 
four straight 
pieces of tubing 
from the clip on 
the Dionex ICS-
1100 or Dionex 
ICS-1600 rear 
panel (see 
Figure 2).

Figure 2.  RFIC-ER Tubing and Tubing Clip

4. Lift up and 
remove the panel 
covering the 
RFIC-ER 
compartment on 
the right side of 
the Dionex ICS-
1100 or Dionex 
ICS-1600 (see 
Figure 3).

Figure 3.  RFIC-ER Compartment Panel

During the initial setup, the pump in the Dionex ICS-1100 or Dionex
ICS-1600 is used to condition the ER1 column and test the system for
leaks. In order to use this pump, the ERC 10 must not be present in
the instrument or timebase.

Tubing
Chase

Release tubing 
from clip

Remove
panel
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5. Release the tubing from 
the clip on the left wall 
of the RFIC-ER 
compartment (see 
Figure 4).

Figure 4.  RFIC-ER Compartment Tubing Clip

6. Locate the ER3a and ER3b column 
assembly (anion assembly, 
P/N 068202; cation assembly, 
P/N 067803) in the RFIC-ER 
Installation Kit (see Figure 5).

Tubing is connected to the ER3a 
column inlet and from the ER3a 
column outlet to the ER3b column 
inlet. Do not remove this tubing or 
loosen the fittings.

Figure 5.  ER3a/ER3b Column Assembly

ERC 10

Tubing
Clip

ER3b

ER3a
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7. Remove the plug from the ER3b column outlet. Connect the short 

1/8-in OD PTFE (polytetrafluoroethylene) tube from the left side of 
the ERC 10 (in the RFIC-ER compartment) to the ER3b column 
outlet.

8. Remove the acorn nut, fitting, and ferrule from the long 1/8-in OD 
PTFE tube connected to the right side of the ERC 10. (The tubing is 
labeled To Eluent Bottle In.) Feed this tube through the chase in the 
upper right corner of the RFIC-ER compartment until it emerges from 
the tubing chase in the upper left corner of the rear panel.

NOTE Save the fitting and ferrule; you will use them in
Section 6.7. You may discard the acorn nut.

9. Note the arrow on the ER3a and ER3b column labels. Install the 
columns, with the arrows pointing upward, on the mounting clips 
located on the ERC 10. Install the ER3a column on the right side of 
the compartment and the ER3b column on the left side (see Figure 6).

NOTE The arrow on the column label indicates the
direction of flow.

Figure 6.  Installing the ER3a and ER3b Columns in the RFIC-ER Compartment

ER3b

ER3a

Arrow on 
labels must 
point upward



Dionex ICS-1100/ICS-1600 RFIC-ER Kit Installation

12 Doc. 065295-03 10/12

10. Remove the acorn nut, fitting, and ferrule from the green tubing 
connected to the ER3a column inlet. (The tubing is labeled SRS 

Regen Out.) Insert this end of the tubing into the waste drain hole in 
the RFIC-ER compartment (see Figure 7) and push the tubing until it 
emerges from the drain tubing in the component panel (see Figure 8).

If a column heater is installed, you will need to remove it temporarily 
to avoid blockage of the green tubing.

NOTE Save the fitting and ferrule. You may discard
the acorn nut.

11. Reinstall the fitting and ferrule onto the tubing connected to the inlet 
of the ER3a column. Connect the end of the green tubing labeled SRS 

Regen Out to the suppressor Regen Out port, and route the tubing 
behind the column holder for neatness (see Figure 8).

12. If you removed the column heater in Step 10, reinstall it now.

Figure 7.  Routing the ER3a Column Inlet Tubing

Waste
Drain Hole
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Figure 8.  Connecting the SRS Regen Out Tubing (Dionex ICS-1100 Shown)

SRS Regen Out Line

Route Regen Out 
line behind column 
holder

Route Regen Out line 
behind column 
holder

Drain Tubing from 
RFIC-ER 
Compartment
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6.2 Installing the Eluent Bottle

1. Prepare 4 liters of the eluent 
required for the application. 
Always use ASTM Type I 
(18 megohm-cm) filtered, 
deionized water when preparing 
eluent.

2. Note the minimum and maximum 
fill marks on the eluent bottle (see 
Figure 9). Add fresh eluent up to 
the maximum fill mark.

Figure 9.  Eluent Bottle Fill Marks

3. Screw the cap onto the eluent 
bottle. Check that the two gas vents 
are seated in the cap and are free of 
obstructions (see Figure 10).

Figure 10.  Gas Vents in Eluent Bottle Cap

If the eluent level falls below the minimum fill mark, the outlet tubing
may not reach the fluid level and the pump may lose prime.

Do not block the gas vents in the eluent bottle cap. If the ERC 10
malfunctions, the gas vents must be able to discharge any hydrogen
and oxygen gases produced by the electrolytic suppressor to the
atmosphere.

N’obturez pas les évents du bouchon de la bouteille d’éluant. En cas
de défaillance de l’ERC 10, les évents doivent pouvoir évacuer vers
l’atmosphère l’hydrogène et l’oxygène produits par le suppresseur
électrolytique.

Maximum Fill
Mark (4 L)

Minimum Fill Mark
(About 3.7 L)

Gas Vents
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4. Push the Eluent Bottle Out tubing down so that the tubing label is 
against the cap, and then connect the tubing to the pump inlet line.

5. Prime the pump.

6. Make sure the suppressor has been hydrated as instructed in the SRS 
300 QuickStart. Suppressor manuals are provided on the Thermo 
Scientific Reference Library DVD (P/N 053891).

6.3 Plumbing the ER1 Column for Conditioning

1. Disconnect the tubing labeled TO INJ VALVE IN - P from port P (2) on 
the injection valve. 

2. Locate the tubing/coupler assembly labeled PUMP OUT in the lower 
left tubing chase of the component panel. Connect the tubing just 
removed from the injection valve to the tubing/coupler assembly (see 
Figure 11).

Blockieren Sie keinesfalls die Öffnungen im Deckel der
Eluentenflasche. Wenn der ERC 10 nicht korrekt arbeitet, müssen die
vom elektrolytischen Supressor erzeugten Wasserstoff- und
Sauerstoffgase über diese Öffnungen in die Atmosphäre gelangen
können.

Figure 11.  Connecting the ER1 Column for Conditioning

Connect TO INJ VALVE IN - P
tubing to tubing assembly,
using PUMP OUT coupler
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3. Locate the ER1 column in the RFIC-ER Consumables Kit.

4. In the RFIC-ER compartment, remove the coupler connecting the two 
black tubes (ER1 IN and ER1 OUT). Connect the tubing labeled ER1 IN 

to the ER1 column inlet. Connect the tubing labeled ER1 OUT to the 
ER1 column outlet. 

5. Mount the ER1 column (with the inlet end at the top) onto the ER3a 
column, using one of the two ER1/ER2 bracket clips (P/N 069671) 
provided in the RFIC-ER Installation Kit. Install the ER1 column to 
the right of the ER3a and ER3b column assembly (see Figure 12).

Figure 12.  Mounting the ER1 Column in the RFIC-ER Compartment

ER1 Column

ER3a

ER3b
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6. Note the tubing labeled InjVlv P extending from the lower tubing 
chase on the component panel. Direct the end of this tubing to a small 
waste container (see Figure 13).

6.4 Conditioning the ER1 Column

1. Verify that the suppressor is off.

2. Set the pump flow rate to 2.0 mL/min and turn on the pump.

3. Rinse the ER1 column with eluent for 30 minutes. Make sure the 
suppressor is not activated during this time.

4. After 30 minutes, turn off the pump.

Figure 13.  Completing Connections for ER1 Column Conditioning 

To avoid damaging the suppressor, always turn off the suppressor
before conditioning the ER1 column. Although the pump flow is on
during conditioning, no flow will reach the suppressor.

Direct InjVlv P tubing from
tubing chase to waste
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6.5 Completing the ER1 Column Connections

Remove the tubing labeled InjVlv P from the waste container. Connect the 

tubing to port P (2) on the injection valve (see Figure 14).

Figure 14.  Connecting the ER1 Column to the Injection Valve



Initial Setup for Dionex ICS-1100/ICS-1600 Systems

Doc. 065295-03 10/12 19

6.6 Installing the ER2 Column

1. Disconnect the black PEEK™ tubing that connects the Cell Out port of 
the detector cell to the suppressor Regen In port.

2. Note the green tubing labeled Cell Out extending from the lower left 
tubing chase on the component panel. Connect this tubing to the Cell 

Out port of the detector cell (see Figure 15).

3. In the RFIC-ER compartment, remove the coupler connecting the two 
pieces of green tubing (ER2 IN and ER2 OUT).

4. Connect the tubing labeled ER2 IN to the inlet of the ER2 column.

5. Connect the tubing labeled ER2 OUT to the outlet of the ER2 column. 
Connect the other end of this tubing (which is labeled SRS REGEN IN 

and extends from the lower left tubing chase) to the suppressor Regen 

In port.

Figure 15.  Connecting the ER2 Column to the Detector Cell

Connect green Cell Out 
tubing to Cell Out port
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6. Mount the ER2 column (with the inlet end at the top) onto the ER3b 
column, using the remaining ER1/ER2 bracket clip (P/N 069671) 
from the RFIC-ER Installation Kit. Install the ER2 column to the left 
of the ER3a and ER3b column assembly (see Figure 16).

Figure 16.  Mounting the ER2 Column in the RFIC-ER Compartment

ER3b

ER2 Column

ER1/ER2
Bracket Clip

ER3a
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7. Gather together all of the loose tubing in the RFIC-ER compartment, 
press the tubing into the clip on the left wall, and close the clip (see 
Figure 17). 

6.7 Directing the ERC 10 Eluent Line to Waste

In Section 6.1, Step 8, you routed the 1/8-in OD PTFE tube (labeled To 

Eluent Bottle In) from the ERC 10 to the tubing chase in the upper left 
corner of the Dionex ICS-1100 or Dionex ICS-1600 rear panel (see 
Figure 2).

Now, direct the free end of the PTFE tube to a small waste container.

Figure 17.  Routing the Tubing Through the Tubing Clip

Route tubing
through the
tubing clip
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6.8 Testing for Leaks

1. Turn on the pump and suppressor at the appropriate flow rate and 
current (see the following table).

NOTE The CS16 Cation Separator has a 5-mm ID. All
other columns listed here have a 4-mm ID.

2. Begin operating the system for 3 hours (i.e., with the system not 
operating in the recycled mode of operation). During this time, 
periodically check all tubing connections for leaks. Tighten any 
connections that leak.

After 1.5 hours, check the eluent bottle. If the eluent level is below 
the minimum fill mark (see Figure 9), turn off the system, refill the 
eluent bottle, and restart the system.

Separator Column Recommended 
Flow Rate

Maximum Suppressor 
Current

AS4A-SC Anion 
Separator

2.0 mL/min 27 mA

AS9-HC Anion 
Separator

1.0 mL/min 45 mA

AS12A Anion 
Separator

1.5 mL/min 25 mA

AS14 Anion Separator 1.2 mL/min 25 mA

AS14A Anion 
Separator

1.0 mL/min 43 mA

AS22 Anion Separator 1.2 mL/min 31 mA

AS23 Anion Separator 1.0 mL/min 25 mA

CS12A Cation 
Separator

1.0 mL/min 59 mA

CS16 Cation Separator 1.0 mL/min 88 mA

If the eluent level falls below the minimum fill mark, the outlet tubing
may not reach the fluid level and the pump may lose prime.
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3. After 3 hours of total operation time, shut down the system.

4. Remove the 1/8-in OD PTFE tube (labeled To Eluent Bottle In) from 
the waste container. Allow the fluid in the tubing to drain into the 
waste container.

5. Disconnect the green tubing labeled SRS REGEN OUT from the 
suppressor SRS Regen Out port and allow the fluid to drain into a 
waste container.

6. Connect the end of the green tubing you just disconnected to a 1/4-28 
union (P/N 039056), a luer adapter (P/N 024305), and a 10 cc syringe 
(P/N 079803) (see Figure 18). Pull all remaining fluid (about 16 cc) 
from the ERC 10 until only air is exiting the controller.

7. Remove the union, luer adapter, and syringe from the tubing labeled 
SRS REGEN OUT.

8. Reconnect the green tubing to the suppressor SRS Regen Out port.

9. Install the fitting and ferrule removed in Section 6.1, Step 8, on the 
end of the long 1/8-in OD PTFE tube labeled To Eluent Bottle In. 
Connect this end of the tube to the fitting and coupler on the Eluent In 

line to the eluent bottle. 

10. Add eluent up to the maximum fill mark on the eluent bottle (see 
Figure 9).

Figure 18.  Drawing Fluid from the ERC 10
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7. Chromeleon Setup

7.1 RFIC-ER System Requirements

The RFIC-ER system consumables have limited life spans and require 
periodic replacement or regeneration. The Chromeleon RFIC-ER 
Wellness feature tracks the usage of the consumables and notifies you 
when they approach the end of their useful life spans. When Chromeleon 
is disconnected from the Dionex ICS-1100 or Dionex ICS-1600, the IC 
system firmware monitors the consumables usage and stores the tracking 
information in its permanent memory. 

In order to operate in the RFIC-ER mode, you need an ERC 10 (standard 
on all Dionex ICS-1100 and Dionex ICS-1600 instruments), as well as the 
appropriate software version:

• Chromeleon 7 DU0b (or later)

– or –

• Chromeleon 6.8 SR6a (or later)

Chromeleon automatically activates the RFIC-ER features in the 
firmware when it detects the presence of an ERC 10.

7.2 Updating Chromeleon

Check the Chromeleon release installed on the PC. If necessary (see 
Section 7.1), run Chromeleon Setup to install the software update.

7.3 Configuring the ERC 10 Properties

NOTE If the ERC 10 driver was installed during initial
installation of the Dionex ICS-1100 or Dionex ICS-
1600, go directly to Step 3 now to add the ERC 10 to
an instrument (Chromeleon 7) or a timebase
(Chromeleon 6.8).

1. The ERC 10 is connected to a USB connector inside the Dionex ICS-
1100 or Dionex ICS-1600. When the IC system is connected to the 
PC, Microsoft Windows will immediately detect the ERC 10 and 
launch the Found New Hardware Wizard. Follow the instructions in 
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the wizard to install the ERC 10 driver. During installation, select the 
following options:

• If asked whether Windows can connect to Windows update to 
search for software, select No, not this time.

• Accept the default option (Install the software automatically) 
and click Next >. (It is not necessary to insert a hardware 
installation CD-ROM.)

2. When the ERC 10 driver has been installed, click Finish.

3. In the Chromeleon 7 Instrument Configuration program: Right-click 
the instrument that contains the RFIC-ER system and select Add 
Module. The Add module to instrument dialog box (see below) 
appears.

In the Chromeleon 6.8 Server Configuration program: Right-click the 
timebase that contains the RFIC-ER system and select Add Device. 
The Add device to timebase dialog box appears. 

4. In the Manufacturers list box, select Dionex IC: Integrated 
Systems.
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5. In the Modules (Chromeleon 7) or Devices (Chromeleon 6.8) list 
box, select ERC 10 Controller.

6. Click OK to add the ERC 10 to the instrument or timebase.

The ERC 10 Properties dialog box appears.

7. On the General tab, make sure that Live mode is selected. 

8. If more than one ERC 10 is connected to the server, select the correct 
ERC 10 from the Module Serial No. list. (The serial number is on the 
ERC 10 label.)

9. Click OK.

NOTE If two ERC 10 controllers are to be placed in the
same instrument or timebase, rename the
second controller “Controller_2.”
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7.4 Configuring the Dionex ICS-1100/ICS-1600 Properties

1. In the Instrument Configuration program (Chromeleon 7) or Server 
Configuration program (Chromeleon 6.8), right-click the Dionex 
ICS-1100 or Dionex ICS-1600 to open the system Properties dialog 
box.

2. Click the Options tab in the Properties dialog box. (In this example, 
the system is a Dionex ICS-1600 and the chromatography data 
system is Chromeleon 7.)

3. Under Degas, verify that Monitor is selected.

4. Under Link to ERC Controller, select the controller installed in the 
system. 

5. Click OK.
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6. Exit the Instrument Configuration program or Server Configuration 
program. When asked whether to save the configuration changes, 
click Save.

NOTE Go on to Section 8 to check the RFIC-ER
Wellness panel settings.

8. Confirming the RFIC-ER Wellness Settings

8.1 Chromeleon 7 Wellness Settings

1. To start the Chromeleon 7 client, click Start > All Programs > 
Chromeleon 7 > Chromeleon 7.

The Chromeleon Console (including the ePanel Set for the Dionex 
ICS-1100 or Dionex ICS-1600) appears.

2. On the Dionex ICS-1100 or Dionex ICS-1600 ePanel, under ERC 10 
Controller, click More Details to view the RFIC-ER Wellness panel 
(see Figure 19).

3. Check the following RFIC-ER Wellness panel settings:

a. Verify that the Chemistry Type matches the column chemistry 
you plan to run.

b. Under ER1 Expiration Information, ER2 Expiration 
Information, and Eluent Expiration Information, verify that 
the counters are set to zero. If a counter is set to a value other than 
zero, click the corresponding Reset button.

c. Check that the current status (displayed in the upper left corner) is 
Connected.

d. Under ERC 10 Controller, verify that the Mode is either 
Operation or Power-up.

e. Click the Reboot ERC 10 button.

If a new or freshly-regenerated SRS 300 Suppressor is installed in the 
RFIC-ER system, go on to Section 9 to condition the suppressor.
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If the installed suppressor is not new or freshly-regenerated, this 
completes the RFIC-ER installation procedure. Before starting 
operation, review the operating guidelines in Section 10.

Figure 19.  Example Chromeleon 7 RFIC-ER Wellness Panel
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8.2 Chromeleon 6.8 Wellness Settings

1. To start the Chromeleon 6.8 client, click Start > All Programs > 
Chromeleon > Chromeleon.

The main window and Browser appear.

2. Select View > Default Panel Tabset to display the panel tabset for 
the Dionex ICS-1100 or Dionex ICS-1600.

3. Click the RFIC-ER Wellness tab on the panel tabset to view the 
RFIC-ER Wellness panel (see Figure 20).

Figure 20.  Example Chromeleon 6.8 RFIC-ER Wellness Panel

4. Check the following Wellness panel settings:

a. Verify that the Chemistry Type matches the column chemistry you plan 
to run.

b. Under ER1 column, ER2 column, and Eluent, verify that the counters 
are set to zero. If a counter is set to a value other than zero, click the 
corresponding Reset button.

c. Under ERC 10 Controller, verify that the Connected check box is 
selected and that the Mode is either Operation or Power-up.
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d. Click the Reboot ERC 10 button.

If a new or freshly-regenerated SRS 300 Suppressor is installed in the 
RFIC-ER system, go on to Section 9 to condition the suppressor.

If the installed suppressor is not new or freshly-regenerated, this 
completes the RFIC-ER installation procedure. Before starting operation, 
review the operating guidelines in Section 10.

9. Conditioning the Suppressor

A new (or freshly-regenerated) SRS 300 Suppressor must be conditioned for 
16 hours before it is ready for operation in the recycled eluent mode. During this 
conditioning procedure, the SRS 300 screens and membranes are equilibrated into 
the state required for compatibility with RFIC-ER operation.

1. Turn on the pump and suppressor at the flow rate and current settings 
recommended for the installed separator column (see Section 6.8). 

2. If the RFIC-ER Wellness panel is not already displayed, display it now. For 
instructions, see Section 8.1 (Chromeleon 7) or Section 8.2 (Chromeleon 6.8).

3. To start the conditioning procedure, click Condition Suppressor under 
Suppressor Information (Chromeleon 7) or ERC 10 Controller 
(Chromeleon 6.8) on the RFIC-ER Wellness panel.

4. While conditioning is underway, periodically check all tubing connections for 
leaks; tighten any connections that leak. To monitor the status of the 
conditioning procedure, check the Remaining Time under Eluent 
Expiration Information (Chromeleon 7) or Eluent (Chromeleon 6.8).

If the pump unexpectedly stops running and Chromeleon displays the “Pump 
stopped due to RFIC” message in the Audit Trail, follow the appropriate steps 
to resume the conditioning procedure.

a. Click Reset Gas Volume (under ERC 10 Controller) to enable the pump 
again. 

b. Click Reboot ERC 10 to prevent the ERC 10 from deactivating the pump 
for 3 hours.
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5. When the conditioning procedure finishes, the system automatically shuts 
down and Chromeleon displays the following message in the Audit Trail: 
“The eluent has expired and needs to be replaced now. The pump has been 
shut down to protect the guard and analytical columns.”

6. Dispose of the used eluent in the eluent bottle. Prepare 4 liters of fresh eluent 
and add eluent up to the maximum fill mark on the bottle (see Figure 9).

7. Disconnect the ERC 10 outlet line from the eluent bottle and direct it to a 
waste container. Operate the system for 30 minutes to flush out the expired 
eluent.

8. After 30 minutes, turn off the pump. Reconnect the Eluent Bottle In tubing to 
the ERC 10 outlet.

9. Add eluent up to the maximum fill mark on the eluent bottle (see Figure 9).

The RFIC-ER system is now ready for up to four weeks of nonstop operation. 
Before starting operation, review the operating guidelines in Section 10.

10. RFIC-ER System Operating Guidelines

For complete operating instructions, refer to the operator’s manual for the Dionex 
ICS-1100 or Dionex ICS-1600. The guidelines here are intended to supplement, 
not to replace, the information in the operator’s manuals.

• RFIC-ER is compatible with carbonate/bicarbonate eluents (for anion 
separations) and methanesulfonic acid eluents (for cation separations) only.

• RFIC-ER can only regenerate the original eluent; therefore, RFIC-ER is 
compatible with isocratic separations only and cannot be used with detection 
systems that alter the eluent composition, such as post-reagent delivery and 
the CRD 300.

• RFIC-ER is not compatible with any eluents containing organic solvents. The 
eluents in an RFIC-ER system must be 100% aqueous.

• The capacities of the various trap columns in the RFIC-ER system are limited; 
therefore, RFIC-ER is compatible only with low-contaminant water samples 
such as drinking water, surface water, and ground water.

If the eluent level falls below the minimum fill mark, the outlet tubing
may not reach the fluid level and the pump may lose prime.



RFIC-ER System Operating Guidelines

Doc. 065295-03 10/12 33

• During an injection on an RFIC-ER system, the equivalent volume of eluent is 
exchanged with the sample injected. Because sample ions are trapped by the 
columns, the eluent is diluted. The RFIC-ER system is designed to handle a 
pre-defined volume of injected samples before the eluent needs replacement. 
Injections of samples in excessive volumes—whether due to a large number 
of small injections or a smaller number of injections with large sample 
loops—will dilute the eluent and cause unacceptable retention time drift. 
Chromeleon monitors the sample volume injected and displays a warning to 
replace the eluent when the limit is approached.

• When running sequences, the RFIC-ER Wellness feature uses the current 
injection volume to monitor the volume of sample that is injected into the 
system and to calculate the number of injections that remain. Before the first 
injection, Chromeleon may be unable to calculate the number of remaining 
injections; however, the affected eluent and trap column counters on the 
RFIC-ER Wellness panel will correct themselves when the first injection is 
made. 

• When injecting samples manually, or with a Thermo Scientific Dionex AS-
DV Autosampler, be sure the injection volume specified in the Chromeleon 
sequence matches the sample loop size.

• It is not necessary to re-equilibrate the system unless you replace the eluent or 
one of the trap columns. Because the RFIC-ER system remains on 
continuously, the system is always equilibrated and ready for operation.

Entering the wrong injection volume in the sequence will impair the
accuracy of the eluent and trap column counters on the RFIC-ER
Wellness panel; this will impair proper operation of the RFIC-ER
system.



Dionex ICS-1100/ICS-1600 RFIC-ER Kit Installation

34 Doc. 065295-03 10/12

11. RFIC-ER System Maintenance

11.1 Replacing the Eluent

When to replace the eluent

The RFIC-ER Wellness feature in 
Chromeleon monitors eluent use and 
the total volume of sample injected 
into the system. When the limit for 
either of these parameters is reached, 
an Audit Trail message will inform 
you that it is time to replace the 
eluent.

You can check the life expectancy of 
the eluent at any time by reviewing 
the status information on the RFIC-
ER Wellness panel. (The example screen shot here is from Chromeleon 
7.) For details about these parameters, see the following table.

Operation Time The number of hours the eluent has been in use.

Remaining Time The number of hours until the eluent expires. After 
672 hours (28 days), the eluent will expire and must be 
replaced.
Note: This time limitation is independent of pump 
operation; the eluent will expire after 672 hours (28 days) 
even if the system is not operated during this time.

Volume Injected The volume of sample injected since the last eluent 
change. When the Volume Injected is 20,000 L, the 
eluent has expired and must be replaced.
Note: Repeated sample injections cause eluent dilution. 
Operating the system with diluted eluent will cause 
excessive retention time drift; for details, see Section 10.

Remaining Inj. 
Volume

The volume of sample that can be injected before the 
eluent expires.
Resetting the eluent counter resets the Remaining Inj. 
Volume to zero, also. When you start the next injection, 
the Remaining Inj. Volume will be updated to the 
correct value.
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How to replace the eluent

1. Check that the pump and suppressor are turned off.

2. Disconnect the Eluent Bottle Out tubing from the pump.

3. Disconnect the tubing from the ERC 10 (labeled To Eluent Bottle In) 
from the Eluent Bottle In line at the connection near the eluent bottle.

4. Remove the cap from the RFIC-ER eluent bottle and dispose of the 
expired eluent.

5. Prepare 4 liters of the eluent required for the application. Always use 
ASTM Type I (18 megohm-cm) filtered, deionized water when 
preparing eluent.

6. Add eluent up to the maximum fill mark on the bottle (see Figure 9).

7. On the RFIC-ER Wellness panel, under Eluent Expiration 
Information (Chromeleon 7) or Eluent (Chromeleon 6.8), click the 
Reset EC button. This resets the Operation Time to zero and resets 
the Remaining Time to 672 hours.

To ensure the accuracy of the Remaining Inj. Volume,
be sure to enter the correct injection volume in the
Inj. Vol. column of the sequence table.

Injections Made The number of sample injections since the last eluent 
change.

Injections 
Remaining 
(Chromeleon 7), 
Remaining 
Injections 
(Chromeleon 6.8)

The number of samples that can be injected before the 
eluent expires.

Reset EC Clicking Reset EC resets the eluent counter, resetting the 
Operation Time and Remaining Inj. Volume to zero. 
Click Reset EC only after replacing the eluent.

Always neutralize methanesulfonic acid eluents before disposal.

For optimal RFIC-ER system operation, do not reuse expired eluent.
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8. Reconnect the pump inlet line to the Eluent Bottle Out tubing. Direct 
the ERC 10 outlet tubing to a waste container.

9. Prime the pump. (If you need instructions, refer to Chapter 5 of the 
operator’s manual for the Dionex ICS-1100 or Dionex ICS-1600.) 

10. After priming the pump, check that the eluent level is above the 
minimum fill mark on the eluent bottle (see Figure 9). If necessary, 
add more eluent to the bottle.

11. Select the standard flow rate and current settings for the application. 
Operate the system for 30 minutes to flush the expired eluent from the 
system. If the pump stops running and Chromeleon displays the 
“Pump stopped because the total gas volume has exceeded the limit” 
message in the Audit Trail, follow the appropriate steps below. 

a. On the RFIC-ER Wellness panel, under ERC 10 Controller, 
click Reset Gas Volume (Chromeleon 7) or Gas Volume Reset 
(Chromeleon 6.8). This resets the gas volume to 0.00 mL.

b. Restart the pump and suppressor and monitor the Total Gas 
Volume (Chromeleon 7) or Gas Volume (Chromeleon 6.8) 
reading. If the value begins to climb toward 0.60 mL, click 
Reboot ERC 10. This disables the gas monitor for 3 hours. 

c. If, after 3 hours, the gas volume reading is still increasing, shut 
down the system. For troubleshooting assistance, contact 
Technical Support for Dionex products. In the U.S., call 1-800-
346-6390. Outside the U.S., call the nearest Thermo Fisher 
Scientific office.

12. After 30 minutes of flushing eluent from the system, turn off the 
pump.

13. Remove the ERC 10 outlet tubing from the waste container. Connect 
the outlet of the ERC 10 to the Eluent Bottle In tubing. 

If the eluent level falls below the minimum fill mark, the outlet tubing
may not reach the fluid level and the pump may lose prime.

Do not operate the system with the gas monitor deactivated for an
extended period of time.
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14. Add eluent up to the maximum fill mark on the eluent bottle (see 
Figure 9).

15. Restart the pump and suppressor. The system is now ready for routine 
operation.

11.2 Replacing the ER1 Column

When to replace the ER1 column

The RFIC-ER Wellness feature in Chromeleon monitors the use of the 
ER1 column. An Audit Trail message will inform you when it is time to 
replace the column. (The ER1 column cannot be regenerated.)

You can check the life expectancy of 
the ER1 column at any time by 
reviewing the status information on 
the RFIC-ER Wellness panel. (The 
example screen shot here is from 
Chromeleon 7.) For details about 
these parameters, see the following 
table. 

Never operate an ER1 column beyond its expiration; this may result in
irreversible loss of capacity to the guard and analytical columns.

Capacity 
Consumed (%)

The percentage of the ER1 column that has been 
consumed. When the Capacity Consumed is 100%, the 
ER1 column has expired and must be replaced.

Capacity 
Remaining (%) 

The percentage of the ER1 column that is remaining. 
When the Capacity Remaining is 0%, the ER1 column 
has expired and must be replaced.

Expiration Date 
(Chromeleon 7)

The final day of operation for the ER1 column.

Reset ER1 Clicking Reset ER1 resets the ER1 column counters, 
resetting the parameters above to 0%. Click Reset ER1 
only after replacing the ER1 column.
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How to replace the ER1 column

1. Check that the pump and suppressor are turned off.

2. Remove the old ER1 column from the ER1/ER2 column bracket clip 
in the RFIC-ER compartment.

3. Remove the tubing from the inlet and outlet of the old ER1 column. 
Discard the column.

4. Remove the column plugs from the new ER1 column.

5. In the RFIC-ER compartment, connect the tubing labeled ER1 IN to 
the inlet of the new ER1 column. Connect the tubing labeled ER1 OUT 

to the outlet of the new ER1 column. 

6. Mount the new ER1 column (with the inlet end at the top) onto the 
ER3a column, using the ER1/ER2 bracket clip. Install the ER1 
column to the right of the ER3a and ER3b column assembly (see 
Figure 12).

7. Disconnect the tubing labeled InjVlv P from port P (2) on the injection 
valve. Direct the end of this tubing to a small waste container (see 
Figure 13).

8. Set the pump flow rate to 2.0 mL/min and begin pumping the 
operating eluent through the ER1 column for 20 minutes. Make sure 
the suppressor does not activate during this time. 

If the pump stops running and Chromeleon displays the “Pump 
stopped because the total gas volume has exceeded the limit” 
message in the Audit Trail, follow the appropriate steps below. 

a. On the RFIC-ER Wellness panel, under ERC 10 Controller, 
click Reset Gas Volume (Chromeleon 7) or Gas Volume Reset 
(Chromeleon 6.8). This resets the gas volume to 0.00 mL.

b. Restart the pump and suppressor and monitor the Total Gas 
Volume (Chromeleon 7) or Gas Volume (Chromeleon 6.8) 
reading. If the value begins to climb toward 0.60 mL, click 
Reboot ERC 10. This disables the gas monitor for 3 hours. 

c. If, after 3 hours, the gas volume reading is still increasing, shut 
down the system. For troubleshooting assistance, contact 
Technical Support for Dionex products. In the U.S., call 1-800-



RFIC-ER System Maintenance

Doc. 065295-03 10/12 39

346-6390. Outside the U.S., call the nearest Thermo Fisher 
Scientific office.

9. After rinsing the ER1 column for 20 minutes, turn off the pump.

10. Remove the tubing labeled InjVlv P from the waste container. 
Connect the tubing to port P (2) on the injection valve.

11. On the RFIC-ER Wellness panel, under ER1 Expiration 
Information (Chromeleon 7) or ER1 (Chromeleon 6.8), click Reset 
ER1.

12. Add eluent up to the maximum fill mark on the eluent bottle (see 
Figure 9). 

13. Restart the pump and suppressor. The system is now ready for routine 
operation.

11.3 Replacing the ER2 Column

When to replace the ER2 column

The RFIC-ER Wellness feature in Chromeleon monitors the use of the 
ER2 column. An Audit Trail message will inform you when it is time to 
replace the column. 

Thermo Scientific recommends replacing the ER2 column when it 
expires. However, it is possible to regenerate the column. For instructions 
on replacing the ER2 column, see page 41. For instructions on 
regenerating the ER2 column, see page 42.

When the gas monitor is deactivated, do not operate the system for an
extended period of time.

If the eluent level falls below the minimum fill mark, the outlet tubing
may not reach the fluid level and the pump may lose prime.

Never operate an ER2 column beyond its expiration; this may result in
a buildup of sample co-ions in the eluent, leading to increased
background conductivity and reduced peak areas.
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You can check the life expectancy of 
the ER2 column at any time by 
reviewing the status information on 
the RFIC-ER Wellness panel. (The 
example screen shot here is from 
Chromeleon 7.) For details about 
these parameters, see the following 
table.

Volume Injected The total sample volume injected since the ER2 column 
was installed. When the Volume Injected is 120,000 L, 
the ER2 column has expired.

Volume Remaining 
(Chromeleon 7), 
Remaining Inj. 
Volume 
(Chromeleon 6.8)

The volume of sample that can be injected before the 
sample volume limit (120,000 L) is reached. When the 
Volume Remaining or Remaining Inj. Volume is 0 L, 
the ER2 column has expired.
Resetting the ER2 counter resets the Volume Remaining 
or Remaining Inj. Volume to zero, also. When you start 
the next injection, the Volume Remaining or Remaining 
Inj. Volume will be updated to the correct value.

To ensure the accuracy of the Volume Remaining or
Remaining Inj. Volume, be sure to enter the correct
injection volume in the Inj. Vol. column of the
sequence table.

Injections Made The total number of sample injections since the ER2 
column was installed.

Injections 
Remaining 
(Chromeleon 7), 
Remaining 
Injections 
(Chromeleon 6.8)

The number of sample injections that can be performed 
before the sample volume limit (120,000 L) is reached. 
The Injections Remaining (or Remaining Injections) 
value is based on the volume of the last injected sample; 
if no sample has been injected yet, the reading is zero.

Expiration Date 
(Chromeleon 7)

The final day of operation for the ER2 column.

Reset ER2 Clicking Reset ER2 resets the ER2 column counters, 
resetting Volume Injected and Injections Made to zero. 
Click Reset ER2 only after replacing or regenerating the 
ER2 column.



RFIC-ER System Maintenance

Doc. 065295-03 10/12 41

How to replace the ER2 column

1. Check that the pump and suppressor are turned off.

2. Remove the old ER2 column from the ER1/ER2 column bracket clip 
in the RFIC-ER compartment.

3. Remove the tubing from the inlet and outlet of the old ER2 column. 
Discard the column.

4. Remove the column plugs from the new ER2 column.

5. In the RFIC-ER compartment, connect the tubing labeled ER2 IN to 
the inlet of the new ER2 column. Connect the tubing labeled ER2 OUT 
to the outlet of the new ER2 column.

6. Mount the new ER2 column (with the inlet end at the top) onto the 
ER3b column, using the ER1/ER2 bracket clip. Install the ER2 
column to the left of the ER3a and ER3b column assembly (see 
Figure 16).

7. Select the standard flow rate and current settings for the application. 
Turn on the pump and suppressor and begin pumping the operating 
eluent through the ER2 column for 30 minutes.

If the pump stops running and Chromeleon displays the “Pump 
stopped because the total gas volume has exceeded the limit” 
message in the Audit Trail, follow these steps: 

a. On the RFIC-ER Wellness panel, under ERC 10 Controller, 
click Reset Gas Volume (Chromeleon 7) or Gas Volume Reset 
(Chromeleon 6.8). This resets the gas volume to 0.00 mL.

b. Restart the pump and suppressor and monitor the Total Gas 
Volume (Chromeleon 7) or Gas Volume (Chromeleon 6.8) 
reading. If the value begins to climb toward 0.60 mL, click 
Reboot ERC 10. This disables the gas monitor for 3 hours. 

c. If, after 3 hours, the gas volume reading is still increasing, shut 
down the system. For troubleshooting assistance, contact 
Technical Support for Dionex products. In the U.S., call 1-800-
346-6390. Outside the U.S., call the nearest Dionex Thermo 
Fisher Scientific office.
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8. After rinsing the ER2 column for 30 minutes, turn off the pump.

9. Under ER2 Column on the RFIC-ER Wellness panel, click Reset 
ER2.

10. Add eluent up to the maximum fill mark on the eluent bottle (see 
Figure 9). 

11. Restart the pump and suppressor. The system is now ready for routine 
operation.

How to regenerate the ER2 column

1. Check that the pump and suppressor are turned off.

2. Remove the ER2 column from the ER1/ER2 column bracket clip in 
the RFIC-ER compartment.

3. Disconnect the tubing from the inlet and outlet of the ER2 column.

4. If the ER2 column is an anion column, follow these steps:

a. Prepare fresh 0.5 M sodium bicarbonate solution. Use either 
reagent-grade sodium bicarbonate or undiluted Dionex Sodium 
Bicarbonate Concentrate (0.5 Molar) (P/N 037163).

b. Pump 200 mL of 0.5 M sodium bicarbonate solution through the 
ER2 column. Use either the Trap Column/Suppressor Cleanup 
Kit (P/N 059659) or an accessory pump at 5.0 mL/min. Direct the 
column effluent to a waste container.

c. Pump 40 mL of deionized water through the ER2 column. Use 
one of the following: the Trap Column/Suppressor Cleanup Kit 
(P/N 059659), an accessory pump at 5.0 mL/min, or a syringe. 
Direct the column effluent to a waste container.

d. Go on to Step 6.

When the gas monitor is deactivated, do not operate the system for an
extended period of time.

If the eluent level falls below the minimum fill mark, the outlet tubing
may not reach the fluid level and the pump may lose prime.
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5. If the ER2 column is a cation column, follow these steps:

a. Prepare fresh 0.4 M methanesulfonic acid solution. Use either 
reagent-grade methanesulfonic acid or undiluted Dionex CS12A 
Eluent Concentrate (0.4 Molar) (P/N 057562).

b. Pump 200 mL of 0.4 M methanesulfonic acid solution through 
the ER2 column. Use the Trap Column/Suppressor Cleanup Kit 
(P/N 059659) or an accessory pump at 5.0 mL/min. Direct the 
column effluent to a waste container.

c. Pump 40 mL of deionized water through the ER2 column. Use 
one of the following: the Trap Column/Suppressor Cleanup Kit 
(P/N 059659), an accessory pump at 5.0 mL/min, or a syringe. 
Direct the column effluent to a waste container.

d. Go on to Step 6.

6. Reconnect the tubing labeled ER2 IN to the inlet of the ER2 column. 
Reconnect the tubing labeled ER2 OUT to the outlet of the ER2 
column. 

7. Mount the ER2 column on the ER1/ER2 column bracket clip in the 
RFIC-ER compartment.

8. On the RFIC-ER Wellness panel, under ER2 Expiration 
Information (Chromeleon 7) or ER2 (Chromeleon 6.8), click Reset 
ER2.

12. Adding an Anion Concentrator for Eluent 
Regeneration (AC-ER)

The Anion Concentrator for Eluent Regeneration (AC-ER) column (P/N 072778) 
is a general purpose, extremely low-pressure anion-exchange concentrator with a 
low void volume (approximately 70 µL) and a capacity of 12.0 µeq/column. The 
AC-ER is housed in a 4 × 16 mm column body to reduce the delay volume and 
maximize the number of injections that can be made between eluent exchanges.

With an AC-ER concentrator column installed in an RFIC-ER system, each 
injection adds only 75 µL of sample matrix (70 µL plus 5 µL for connecting 
tubing) into the eluent. Thus, 266 injections can be performed before the eluent 
needs to be replaced, regardless of the amount of sample loaded onto the AC-ER. 
Also, by using a matrix elimination step with the AC-ER column in place, 
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solvents can be directly injected onto the AC-ER and then flushed off before 
injection into the RFIC-ER system. 

The AC-ER column brings a host of new applications within range of RFIC-ER 
systems, including analysis of bromate to 5 ppb in drinking water and analysis of 
common anions in ethanol.

12.1 Installing the AC-ER Concentrator Column

1. Turn off the pump and suppressor.

2. Remove the old injection loop or concentrator column from the 
system injection valve.

3. Cut two short (about 10 cm [or 4 in]) lengths of 0.25-mm (0.010-in) 
ID black tubing. (Tubing not provided.)

4. Connect a length of tubing to both the inlet and outlet ports of the 
AC-ER column.

5. Connect the inlet of the AC-ER column to port 4 of the injection 
valve. Check that the Thermo Scientific Dionex AS-AP Autosampler 
or AS Autosampler is connected to port 3 of the injection valve.

6. Connect the outlet of the AC-ER column to port 1 of the injection 
valve. Check that the waste line is connected to port 2 of the injection 
valve.

12.2 Configuring the AC-ER Concentrator Column Properties

1. Check that data acquisition on all instruments (Chromeleon 7) or 
timebases (Chromeleon 6.8) is turned off.

2. In the Instrument Configuration program (Chromeleon 7) or Server 
Configuration program (Chromeleon 6.8), right-click the Dionex 
ICS-1100 or Dionex ICS-1600 to open the system Properties dialog 
box.

Do not inject ethanol or other solvents directly into an RFIC-ER
system. Before injection, load solvents onto the AC-ER column and
perform a matrix elimination step to remove the solvent matrix.
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3. Click the Options tab in the Properties dialog box. (In this example, 
the system is a Dionex ICS-1600 and the chromatography data 
system is Chromeleon 7.)

4. Select the Concentrator check box.

5. In the Volume field, enter 75. (This is the void volume of the AC-ER 
column (70 µL) plus 5 µL for connecting tubing.)

6. Click OK.

7. Exit the Instrument Configuration program or Server Configuration 
program. When asked whether to save the configuration changes, 
click Save.

12.3 Confirming the RFIC-ER Wellness Settings

1. On the RFIC-ER Wellness panel (Chromeleon 7, see Figure 19; 
Chromeleon 6.8, see Figure 20), verify that the Connected check box 
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is selected. The check box is either in the upper left corner 
(Chromeleon 7) or under ERC 10 Controller (Chromeleon 6.8). 

2. Under ERC 10 Controller, verify that the Mode is either Power-up 
or Operation.

12.4 Configuring the Dionex AS-AP Autosampler (Optional)

To select the configuration injection mode

1. In the Instrument Configuration program (Chromeleon 7) or Server 
Configuration program (Chromeleon 6.8), right-click the AS-AP to 
open the autosampler Properties dialog box.

2. Click the Options tab in the Properties dialog box.
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3. Under Injection Mode, select Push.

NOTE The option selected here determines the
injection modes available in the Instrument
Method Wizard or Program Wizard in the
Chromeleon client. 

4. Click OK.

5. Exit the Instrument Configuration program or Server Configuration 
program. When asked whether to save the configuration changes, 
click Save.

To select the injection mode and syringe speed

1. In Chromeleon 7: Launch the Instrument Method Wizard. Click 
Next > to go to the Injection Mode page.

In Chromeleon 6.8: Launch the Program Wizard. Click Next > to go 
to the first Sampler Options page.

2. Select the Inject Mode option.

3. Click Next > to go to the General Settings page (Chromeleon 7) or 
the second Sampler Options page (Chromeleon 6.8).
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The page lists speed recommendations that are based on the selected 
injection mode, syringe size, and loop size. In most cases, you can 
click Accept recommended values to accept the default settings. To 
change the speed for an option, enter a new value in the 
corresponding Actual box. For a description of each option, click the 
Help button on the page.
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12.5 Configuring the Dionex AS Autosampler (Optional)

1. From the MAIN STATUS screen, press the Menu button to display the 
MENU of SCREENS.

2. Press 5 to go to the MODULE SETUP MENU.

3. Press 5 again to go to the SYSTEM PARAMETERS screen (see 
Figure 21).

4. Move the cursor to the METHOD SYRINGE SPEED field and select the 
speed for the type of sample syringe installed. For guidelines on 
selecting the correct syringe speed, refer to Section 3.8 of the AS 
Autosampler Operator's Manual. The AS manual is provided on the 
Thermo Scientific Reference Library DVD (P/N 053891).

5. Move the cursor to the SAMPLE MODE field and select 
CONCENTRATE.

6. To return to the MAIN STATUS screen:

a. Press Menu twice.

b. Press Enter or 1.

12.6 Operating Guidelines for Concentrator Mode

When operating an RFIC-ER system in concentrator mode, Chromeleon 
uses the Concentrator Volume selected in the Instrument Configuration 
program or Server Configuration program (see Section 12.2) to increment 
the eluent counter and ER2 counter. Use the sequence table to set the 
volume of sample to be loaded onto the AC-ER concentrator column.

Figure 21.  System Parameters Screen

Help Prompt

SYSTEM PARAMETERS
WAIT: ENABLED

METHOD SYRINGE SPEED:
CUT SEGMENT VOLUME:

INJECT PORT VOLUME:

uL

uL

10

43

4

SAMPLE MODE:

FLUSH SYRINGE SPEED: 4

CONCENTRATE
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For complete operating instructions for the AC-ER, refer to the IonPac 
UTAC 2 and AC-ER Product Manual. The manual is provided on the 
Thermo Scientific Reference Library DVD (P/N 053891).

13. Troubleshooting

13.1 Pump Stops Unexpectedly

The ERC 10 electronics monitor the volume of hydrogen gas in the eluent 
stream. If the safety limit is exceeded, the ERC 10 shuts down the pump 
and Chromeleon displays the following message in the Audit Trail: 
“Pump stopped because the total gas volume has exceeded the limit.” 

To return to normal operation

1. If the RFIC-ER Wellness panel is not already displayed, display it 
now. For instructions, see Section 8.1 (Chromeleon 7) or Section 8.2 
(Chromeleon 6.8).

2. Check the controls under ERC 10 Controller. (The example screen 
shot here is from Chromeleon 7.) 

If the Total Gas Volume 
(Chromeleon 7) or Gas Volume 
(Chromeleon 6.8) reading is 
0.60 mL (or higher) or if the 
Mode is Gas Volume Error, it 
indicates that the volume of gas 
exceeds the allowable limit.

Click the Reset Gas Volume 
button to reset the Total Gas 
Volume or Gas Volume and return the Mode to Operation.

3. Restart the pump and suppressor and monitor the gas volume reading. 
If it begins to climb toward 0.60 mL, click Reboot ERC 10. This 
disables the gas monitor for 3 hours. 
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4. After 3 hours, check the RFIC-ER Wellness panel again. If the Total 
Gas Volume or Gas Volume reading is still increasing and the Mode 
is Gas Volume Error, shut down the system. 

For troubleshooting assistance, contact Technical Support for Dionex 
products. In the U.S., call 1-800-346-6390. Outside the U.S., call the 
nearest Thermo Fisher Scientific office.

13.2 Unstable Retention Times

Unstable retention times may indicate that the vacuum degas assembly is 
not operating in Monitor mode.

To select the correct degas mode

1. In the Instrument Configuration program or Server Configuration 
program, right-click the Dionex ICS-1100 or Dionex ICS-1600 to 
open the system Properties dialog box. 

2. Click the Options tab in the Properties dialog box. (In this example, 
the system is a Dionex ICS-1600 and the chromatography data 
system is Chromeleon 7.)

3. Under Degas, select Monitor.

4. Click OK.
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5. Exit the Instrument Configuration program or Server Configuration 
program. When asked whether to save the configuration changes, 
click Save. 
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